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HT3 Version 3.1.0
Data Flow Systems, Inc. is pleased to announce the availability of version 3.1.0 of HT3.
These release notes provide information on the following:
New features and enhancements
Bug fixes
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

New Features and Enhancements
Module Patching Utility (Module Reset): The command line inject tool used by the
patch program and the block inject tool has been modified to allow a module reset.
Custom Screens on HT3 Mobile: To prevent the screen from flickering when
updating the screen data, jquery requests are being used instead of refreshing the
entire page.
Context Sensitive Help in Configuration Editor: The small popup screens have been
replaced with links to the appropriate page in the online HT3 User Guide.
PMT Radio Map Import (DFS Personnel Only) - Tool for importing the radio map
from a PMT project into HT3 has been added. Refer to the "Radio Import Procedure"
readme for more information.

Bug fixes
Configuration Editor (Modbus Driver Flow Control Field) - The Flow Control field in
the Modbus driver panel now saves correctly when the driver configuration is saved.
Configuration Editor (Station Panel Offline and Retry Count Fields) - The Offline and
Retry Count fields no longer change to 0 (zero) when focus is removed from the
input box.
Trender - The trend colors no longer change when a reference line is added.
Conversion Script (DFS Personnel Only) - The ht2-ht3.sql script, which is run on a
system that has been updated from HyperTAC II to HT3, has been updated to
include registry entries added since the initial HT3 release.
Custom HTML Pages: Links to custom HTML pages from within a custom screen now
operate properly. A screen object with a link to a custom HTML page will now open
the HTML page when clicked.
Detail Reports: Detail reports that switch to text output when the report contains a
large amount of data now display properly.
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_310.html
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Hdriver Intermittently Crashing in Systems Using DFP Protocol: The Rx buffer was
increased to accommodate TCU responses that that occasionally exceeded the
maximum message length.
Call Out and Call In - In order to support the new V.92 socket modem, new scripts
that auto detect the modem and convert audio files have been added.
Call Out - Call out no longer crashes when a contact that is referenced in a call out
schedule is removed from the Contact list.
Ladder Management Tool - The script that outputs the list of logic files is now case
insensitive so that logic files with an uppercase .VLB file extension will be included in
the list.
Virutal Points in HT3 Mobile - Virtual points are now listed on HT3 Mobile screens.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_310.html
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HT3 Version 3.0.7
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.7 of HT3.
These release notes provide information on the following:
New features and enhancements
Bug fixes
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

New Features and Enhancements
Pump Activity Report: New station analysis graphs for the pump activity report have
been added. Mouse over the name of a pump to display a report; click the name of
the pump to open the report in a new window. Click the name of the station to open
the station reports - Total Run Time; Total Starts; Minimum, Average, and Maximum
Run Times; Status of "Any Pump" Point.
Force Main Report: This new report measures force main usage. Of the total number
of pumps feeding into a common force main, the chart shows the number of pumps
that are running at any one time. On a system running Symphony Pump and Flow
Management, the report can be used to analyze how Symphony is performing and
determine if any fine tuning is necessary. Symphony is an optional upgrade to HT3.
This pump and flow management software uses SCADA to coordinate the activities
of wastewater pump stations operating on a common force main. Symphony
replaces pump stations' random controls with a synchronization scheme that
prevents pump stations from working against each other. For more information on
Symphony, visit the DFS website at www.dataflowsys.com
Trender:
Changes to font size made in trends are now saved as part of the trends
parameters. This ensures that the desired font size will display the next time
the trend is opened.
An additional way to change start and end dates for trends has been added.
Click the time span display (top left corner) or the end date display (top right
corner) to open the Range Picker. The Range Picker allows you to adjust the
hour, minutes, AM/PM, month, day, and year using either the up and down
scroll buttons or by typing in the desired values.
Drivers: A new driver for use over networks, including cellular networks, has been
developed for HT3. Contact DFS' Sales Department at sales@dataflowsys.com or
321-259-5009 for information on using this driver on your system.

Bug fixes
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_307.html
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Trender: Trends opened from defaults screens now allow adjustments to the trend's
settings; RIM analog point addresses are now listed in the address selection tool;
the vertical reference line that appears when a trend line is clicked or moused over
now disappears when the mouse leaves the trend area.
Restore Screen: Fixed a problem in the restore_screen (used when restoring MySQL
data to the SCADA software) that prevented it from working in HT3.
Reports: The new interface now correctly handles spaces in keywords.
HTML Custom Page Upload: Fixed the upload error that occurred when trying to
upload a custom html page.
TACEM - Fixed the error that occurred when configuring Q points on an emulated
station.
HT3 Mobile: Fixed reporting link when running through port forwarding.
Infoserver: No longer crashes when large floating point entries are written into a
journal.
Backup Script (rdist): New reports database is now included in the backup.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_307.html
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HT3 Version 3.0.6
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.6 of HT3.
These release notes provide information on the following:
New features and enhancements
Bug fixes
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

New Features and Enhancements
Several enhancements have been made to HT3 Mobile:
HT3 Mobile has been updated to use HT3 logins and passwords as well as
partitioning. When you open HT3 Mobile, you will now be required to use the
same login and password you use to gain access to the workstation version of
HT3.
A configurable session time has been added. If HT3 Mobile runs without any
activity for the period configured for session timeout, you will have to log in
again. The default session timeout is set at 300 seconds (5 minutes). Click
"Options" on the HT3 Mobile home page.
Standard reports can now be run from HT3 Mobile. Click "Reports" on the HT3
Mobile home page to generate a Analog, Derived Flow, Detail, Min Max
Average, Pulse, Pump Activity, or Snapshot report. For more information on
these reports, see Creating and Viewing Reports in the HT3 User Guide.
A System Statistics dashboard, similar to the one included in the workstation
version of HT3, is now available in HT3 Mobile. This screen displays
information on the current status of important system-level points, including
Hyper SCADA Server (HSS) AC power and battery voltage, active Hyper Server
Module (HSM) CPU usage, and length of time active HSM has been running
since its last reboot.
Four custom screen templates for 3D TCU stations have been added to Screen
Builder:
3DDUPLEXDUCER - duplex using transducer
3DTRIPLEXDUCER - triplex using transducer
3DDUPLEXFLOATS - duplex using floats
3DTRIPLEXFLOATS - triplex using floats
DFP mode in hdriver has been updated to allow for configuration of RIM analog
points for temperature and VDC (battery voltage).

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_306.html
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Bug fixes
HT3 System Tray: Fixed problem with the system tray not showing disconnected
status when the network connection is lost.
Networking: A configurable netmask option that works with redundant systems has
been added. This configuration must be done by DFS Service Personnel. This
configuration is only necessary when the netmask for the primary and secondary
servers is not a default class C.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_306.html
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HT3 Version 3.0.5
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.5 of HT3.
These release notes provide information on the new features and enhancements included
in this version.
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

New Features and Enhancements
Ladder Manager, a tool for for analyzing and organizing your ladders, has been
added to HT3. The Ladder Manager is available from the "Tools" menu of HT3. See
Using System Troubleshooting and Maintenance Tools: Ladder Manager.
The Comment Log has been updated to include an option to enter a comment for a
date in the past and to view a print-friendly version. See Creating and Viewing
Reports: Comment Log.
Instructions for automating reports using the Windows Task Scheduler have been
added to the HT3 Help. Task Scheduler is a utility in the Windows operating system
that lets you create scheduled automated tasks. This utility can be used to run any
HT3 report on a schedule you create. See Automate a Report Using Task Scheduler.
Two new reports have been added. The Min Max Average report lists the daily
minimum, maximum and average values of each point included in the report. It is
designed for analyzing analog data such as pressure and flow measurements,
chlorine residuals, turbidity, and tank levels. The Snapshot report returns values in
15 minute intervals for each point included in the report. The value returned is the
last value recorded for the point prior to the interval. The Snapshot report is
designed for analyzing analog data such as water plant turbidity measurements and
chlorine and PH levels.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_305.html
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HT3 Version 3.0.4
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.4 of HT3.
A list of bug fixes for version 3.0.4 of HT3 is provided below.
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

Bug fixes
Reports: Added an option for legacy reports for data that is stored in raw format.
This fix only applies to systems that were upgraded from HyperTAC II to HT3.
Upgraded systems will have journal data stored in both the legacy raw format and
the new floating point format. When a HyperTAC II system is upgraded to HT3, the
date the upgrade occurred will be entered in the registry. Reports run on journals
created prior to the upgrade date, must be run using the "Run Legacy
Report" button.
Infoserver: Pulse points are now being logged using floating point values instead of
raw values.
Trender: Combined trends now display properly.
Remote File Distribution (rdist): The rdist script, which is used to backup/copy data
on a redundant Hyper SCADA Server, was updated to eliminate database messages
and add them to the rsync section.
Digipeat Map: The map is now sorted by station number.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_304.html
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HT3 Version 3.0.3
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.3 of HT3.
These release notes provide information on the following:
New features and enhancements
Bug fixes
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

New Features and Enhancements
A new trending tool is included in this release. Trender replaces the old Trend
Viewer and Trend Builder. The interface has been completely redone to make it
more user-friendly - but no functionality has been lost. Improvements include
support for floating point journals, zoom in and out using the scroll wheel on a
mouse, detaching the Trender (opening in a new window) so trends can be viewed
in full-screen mode, and auto range (sets the upper and lower range of the trend to
the minimum and maximum values recorded for the point during the current time
span).
Journals now store floating point values instead of raw values. With the new floating
point journals, the data is converted prior to being logged in the journal and is
stored as "engineering" values. These floating point values are being used in HT3
reports and trends to enhance performance. For large reports, there will be a
noticeable increase in performance due to fewer calculations. Additionally, third
party developers no longer have to do raw-to-float conversions on every raw value
entry for every analog point; they can simply query the floating point journal
directly.
Trends in HT3 Mobile have been updated to support the new floating point database
format.
Hdriver was updated to properly sync TIM configurations on any Configuration Editor
change to a TIM station.
Documentation now includes a search feature and is available in a PDF "book-style"
version for ease of printing.

Bug fixes
HT3 Mobile: Screen images are no longer caching; they are redrawn when status
changes.
Registry Editor: The time zone can now be configured when setting the system's
date and time.
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_303.html
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Syncing Redundant HSMs: Installed the rdate package and updated the boot script
to allow the secondary HSM to sync off the primary.
Traffic Monitor: Updated to decode DFP messages from digipeated sites.
HT3 Mobile/Android: Caching in Android devices now works properly; also fixed
formatting and linking issues.
Digipeat Map: No longer shows NIM or Modbus stations.
Context Sensitive Help: Links are now working.
Restore Script: No longer generates shell error.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_303.html

Page 2 of 2

HT3 Release Notes - Version 3.0.2

9/14/11 3:29 AM

HT3 Version 3.0.2
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.2 of HT3.
These release notes provide information on the following:
Bug fixes
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

Bug fixes
Hdriver/Configuration Editor: A core dump no longer occurs when changing a RIM's
type in Configuration Editor.
HT3 Mobile: All images are now being loaded.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_302.html
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HT3 Version 3.0.1
Data Flow Systems, Inc. is pleased to announce the availability of version 3.0.1 of HT3.
These release notes provide information on the following:
New features and enhancements
Bug fixes
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

New Features and Enhancements
Hdriver has been updated to support points R9 and R10 for remote reset and RTC
hung special events in the new TIM protocol.
Added support for allowing the DFS user to mount a flash drive.

Bug fixes
HT3 Mobile: An error is no longer generated when configuring HT3 Mobile with a
space in the system name; mobile access is now aliased to port 8880.
Infoserver: No longer hangs when a client machine locks up.
System Stats: Fixed the CPU used percentage being reported from the system
statistics script and custom screen.
System Tray Applet: No longer opens a new window when a redundancy take over
occurs.
System Restore: No longer allows a restore of configurations if HT3 is running, but it
will allow all other data to be restored; now allows a system restore from a
HyperTAC II system to an HT3 system.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_301.html
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HT3 Version 3.0
This document discusses HT3 version 3.0. It includes the following:
A brief description of the software
A list of the significant changes made in this release
System Requirements
Instructions for configuring a Windows workstation
A summary of features and detailed functional procedures can be found in the HT3 User
Guide.

Description
HT3 is a network-based SCADA software package installed on the Hyper SCADA Server
(HSS). HT3 monitors and controls in-plant and remote stations from the HSS, which
communicates with stations through a network link or a combination of network and
radio.
Users access HT3 from Windows-based workstations using a Java-enabled Internet
browser. The only software installed on a workstation is a Web browser, Java 1.5 and a
Java policy file (the policy file gives HT3's Java applets permission to write to specific
directories on your computer).

Significant Changes in this Release
Customers familiar with prior releases will notice that HT3 has a new look and feel.
Although the interface and some of the background processes have changed, the software
includes many of the same telemetry tools, quick transfer of information and robustness.

HT3 Mobile is a streamlined version of HT3 optimized for today's smart phones. In HT3
Mobile, users will find all the essential tools needed for working in the field. The features
provided in HT3 Mobile are: alarms, screens, trends and station status. Contact DFS for
information on purchasing this option.

Symphony™ utilizes SCADA to coordinate the system-wide operation of sewer lift
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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stations for the purpose of reducing force main pressures and equalizing flow into a
wastewater treatment plant. The result is a significant reduction in energy costs and a
solution to daily peak-flow problems. Contact DFS for information on purchasing this
option.
Additional significant changes include:
HT3's interface has been reconfigured to provide more screen space; the system
tray has been moved to the top right corner.
Public screens - view-only custom screens that can be placed on your utility
website - are now supported. Contact DFS for information on configuring this option.
"System Stats Viewer" added. This viewer displays information on the current status
of important system-level points, including driver loop time, Hyper SCADA Server
(HSS) AC power and battery voltage, active Hyper Server Module (HSM) CPU usage,
and length of time active HSM has been running since its last reboot.
Three new reports added: Station Config, Modbus Map and Digipeat Map.
Registry Editor added. This is a high-level tool intended for DFS Service Personnel,
but can also be used to set the server's time and date.
Public Screens added. You now have the ability to create screens for general public
viewing and link to them from your utility's website. Public screens don't allow
controls; they are for informational purposes only. Contact DFS for more information
on this feature.
Camera Viewer now supports any network-based camera.
An image picker has been added to Screen Builder. With this tool, you can see
thumbnails of all the images in your library and also enables you to organize and
categorize your images.
A resizable static image object has been added to Screen Builder. This object can be
a .gif, .jpg, or .png image. It supports transparency, can be rotated and flipped, can
be resized, and can have its hue, saturation and brightness adjusted.
Bug fixes:
Download Tool: Files are now sorted alphabetically rather than randomly.
Screen Builder: Increased the contrast of the LED Bar object in Screen Builder.
Configure Voice Tool: The Configure tab of the Configure Voice tool now saves
changes. The Configure Voice tool now loads the standard recordings list when it is
opened.
Module Patching Utility: NIMs now respond to a directory check.
Java Client Audio: Audio now works and no longer produces an error.
Custom Screen Viewer: Partition screens are now loaded.
Configuration Editor: Deleting a station no longer generates an error or causes the
system tray to disconnect and fail new connections.
Telemetry Traffic Tool: No longer loses connection after running for a time.
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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rt_alarm Table: No longer changes the alarm_text field to ONLINE and the value
field to 0 when a module offline clears.
Trender: Adding a point to a trend opened from the Station Status Viewer and then
making changes to the original point no longer ignores the changes or assigns the
original point's information to the newly added point.
Info Server: Determined and fixed cause of infoserver lockup with Java client.
User Login: Java no longer loses login information, which resulted in failed
permissions for control and alarm acknowledgement, when navigating between HT3
utilities.
File Upload Utility: Now works after updating code to use new _FILES method of PHP
5.
Hdriver: NIM Central now replies from the proper port.
OS and MySQL Passwords: DFS and root passwords for the OS and MySQL were
changed.

System Requirements
Minimum Requirements for a Workstation Computer
Windows XP with SP2
Internet Explorer 8.0
Java 1.5

Setting Up a Windows Workstation
Take the following steps to configure a Windows workstation to access HT3:
Edit Hosts File
Change Browser Settings
Install Plug-Ins and Java Policy File
Start HT3

Edit Hosts File
The hosts file allows you to associate a name (for example, ht3) with an IP address.
Editing the hosts file as described below is necessary to allow HT3's applications, such as
Screen Builder and Logic Builder, to save files on the workstation (a Java Policy file is also
required). Adding an entry for HT3 to the hosts file also allows you to use the host name
instead of an IP address to connect to your Hyper SCADA Server through HT3.
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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Note to Users Upgrading from HyperTAC II: You do not need to edit the hosts files of
existing workstations. HT3's Java Policy file also recognizes the host name hypertacii used
by existing HyperTAC II systems.
1. On the Windows taskbar, click the Start button, and then click Run.
2. In the Run box, type one of the following (depending on your OS level) and click
OK:
For Windows XP and newer, type
edit c:\windows\system32\drivers\etc\hosts
For Windows 2000 / NT, type
edit c:\winnt\system32\drivers\etc\hosts
For Windows 95 /98 / ME, type
edit c:\windows\hosts

3. The hosts file opens in MS-DOS Editor.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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4. Place your cursor on a line below the file's comments - lines preceded by a pound
sign (#) - and do the following:
A. Type xxx.xxx.xxx.xxx (where xxx.xxx.xxx.xxx represents the Hyper SCADA
Server's IP address)
B. Press the Tab key
C. Type ht3
5. Select Save As from the File menu. Verify that the name hosts appears in the File
Name field and click OK.

Test Connection to Hyper SCADA Server
After the host file has been edited and saved, use the ping command to verify that your
workstation can connect to the Hyper SCADA Server using the assigned host name.
1. On the Windows taskbar, click the Start button, and then click Run.
2. Type ping ht3 in the Run dialog box and click OK.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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3. A DOS window appears on screen and indicates if a reply has been received from
the Hyper SCADA Server.

Change Browser Settings
Several changes must be made to Internet Explorer's security settings before you can
successfully run HT3.
1. Start Internet Explorer.
2. Select Internet Options from the Tools menu.
3. Click the Security tab and select the Local intranet zone.
4. Click Custom Level...
5. In the Security Settings dialog box, enable the following:
All of the options listed under ActiveX controls and plug-ins
All of the options listed under Cookies
6. Click OK at the Security Settings dialog box.
7. Click OK at the Internet Options dialog box.

Install Plug-Ins and Java Policy File
1. Start Internet Explorer.
http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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2. In Internet Explorer's Address box, type ht3 (the host name assigned to your
Hyper SCADA Server).
3. If the necessary plug-ins are not already installed, the HT3 Plug-Ins page is loaded .
(Note: If the HT3 Plug-Ins page does not automatically load, type
http://ht3/ht3/plugins/index.html in Internet Explorer's Address box.
4. Follow the instructions on the page to install the required HT3 files and plug-ins.

Start HT3
1. When installation of the plug-ins and the Java policy file is complete, type ht3 in
Internet Explorer's Address box.
2. On the HT3 login page, enter your Login and Password and click OK.
3. Bookmark HT3 in your browser or create a shortcut to HT3 on your Windows
desktop.

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/about_rel_300.html
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Obtaining Support
Mail user feedback, bug reports, questions, and software suggestions to:
Data Flow Systems, Inc.
605 N. John Rodes Blvd.
Melbourne, FL 32934
You can also obtain support by:
Visiting our web site (http://www.dataflowsys.com) and clicking the Help Desk button.
Sending email to: service@dataflowsys.com
Calling us directly at 321-259-5009

http://www.dataflowsys.com/pub/cdrom/ocs_cd/HSS/HT3/release_notes/about/support.html
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